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Administering IP/TV Server

This chapter describes how to administer IP/TV Server. Topics covered include:

• About IP/TV Server modes

• Starting IP/TV Server

• About the IP/TV Program Listings window

• Setting IP/TV Server options

• Viewing program information

• Monitoring Server program statistics

• About Capture Device configuration options

• Viewing diagnostic information

• Manually launching programs

• Pruning transmission of data

About IP/TV Server Modes
IP/TV Server multicasts, records, or transfers scheduled programs, and unicasts on-demand 
programs according to the schedules defined in the IP/TV Content Manager. In order for 
the IP/TV Content Manager to direct the IP/TV Server, you must set a few options. For 
information on this option, see the “Setting IP/TV Server Options” section in this chapter.
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About IP/TV Server Modes
IP/TV Server has seven modes of operation:

• Prerecorded file server mode. In this mode, IP/TV Server reads from a prerecorded 
.mpg, .avi, .rtp, .wav, .dat, .mp3, or .asf file and multicasts the streams over the network. 
The file server can multicast files stored on any of its local drives, including CD-ROM 
drives. See Table A-5 for file format descriptions.

• Live-capture mode. In this mode, IP/TV Server multicasts live, compressed video, and 
audio streams. The capture server uses a video capture card to capture data from an 
analog source such as a video camera, video cassette recorder (VCR), or television 
broadcast, and digitizes the audio and video.

• SlideCast mode. In this mode, IP/TV Server captures slides in H.261 from the Server’s 
desktop, which can then be multicast along with other video and audio. Refer to the 
“Setting Up Web Presenter and SlideCast” chapter.

• RTP record mode. In this mode, IP/TV Server records, multicasts or SmallCasts and 
stores them for future replay to the network.

• SmallCast forward mode. In this mode, IP/TV Server forwards a multimedia session 
across one or more nonmulticast-enabled routers (or across the Internet) as a unicast 
transmission, then multicasts to viewers on the remote network segment.

• OnDemand mode. In this mode, IP/TV Server unicasts prerecorded files to viewers at 
the time of their choosing.

• Web Presenter mode. In this mode, you create a live or prerecorded video or audio 
together with a slide presentation. Refer to the “Setting Up Web Presenter and 
SlideCast” chapter.

This chapter provides instructions for administering both prerecorded file and live-capture 
servers. 
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Starting IP/TV Server
A given machine can operate both as a file server and as a live-capture server, subject to the 
following limits:

• Only one live-capture session per server is allowed at any given time. A live session 
includes such programs as live audio and video, live SlideCast, and live audio and video 
and web presentation.

• The number of concurrent prerecorded file server sessions your server can support 
depends on the hardware configuration of the server, CPU speed, memory, disk I/O 
performance, the network interface card, the network bandwidth, and the data rate of the 
files.

We also recommend that you run IP/TV Server on a dedicated machine, and experiment 
to determine how many sessions the server can handle with acceptable performance.

If you need to support a larger number of concurrent sessions of either type, configure 
multiple IP/TV Servers on different machines.

See the “Live Capture and File Format Reference” appendix which lists video formats, 
audio formats, recommended settings for audio and video codec parameters, and capture 
card settings.

Starting IP/TV Server
You can start IP/TV Server in the following ways:

• Automatically (the default)

• Manually 
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About the IP/TV Program Listings Window
Automatically Starting and Operating IP/TV Server
By default, the IP/TV Server launches programs automatically according to the schedule 
set by the Content Manager. 

Step 1 Click Settings>Configure IP/TV Server to view the default settings.

Step 2 Click the Scheduler tab. The following option is selected by default: 
Automatically Start IP/TV Server after system reboot. On Windows NT, you 
must login for the program listing to appear. If unchecked, the application will 
not restart automatically after a system reboot.

Note If you log out of the system, you must close the application first. However, the 
application will restart automatically after a system reboot or you may start the application 
manually upon user logon.

See the “About the IP/TV Program Listings Window” section later in this chapter for a 
description of the window that appears when IP/TV Server starts up.

Manually Starting IP/TV Server
To start IP/TV Server manually, locate and click the program icon for IP/TV Server.

In most cases, the IP/TV Server icon is normally installed in the start menu program folder 
Cisco IP/TV Server, and on the desktop. If you specified other locations during installation, 
review the information you entered during the installation procedure. See the “Performing 
a CD-ROM Installation” section in the “Installing IP/TV Server” chapter.

About the IP/TV Program Listings Window
The Program Listings window, which appears when you start IP/TV Server, only displays 
programs for which this server is responsible. The program listing can include scheduled, 
on-demand, and manually launched programs. Programs served by WMS will not appear 
in the IP/TV Server Program Listings window.

Figure 6-1 shows an example of the Program Listings window with a listing of only 
scheduled programs.
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About the IP/TV Program Listings Window
Figure 6-1 Program Listings Window with Scheduled Programs

The listing is downloaded from the Content Manager each time IP/TV Server starts up and 
again at the interval specified in the IP/TV Server configuration options dialog box. The 
default interval is 30 minutes. See the “Setting IP/TV Server Options” section later in this 
chapter for information about setting the update interval.

The downloaded listing is contained in the file guide.tvg. If the Content Manager is not 
accessible for any reason (for example, if the system is down), IP/TV Server continues to 
use its local file.

By default, all listed programs are enabled. The server will multicast the programs 
according to the schedule set by the Content Manager. 

Note IP/TV channels allow a noncontinous program to preempt a continuous program, 
and are invisible to users of IP/TV Viewer. Refer to the IP/TV Content Manager User Guide 
for more information on channels. 
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About the IP/TV Program Listings Window
When IP/TV Viewer requests an on-demand program, the program listing appears in the 
Program Listings window.

Figure 6-2 shows an example of the Program Listings window with a listing of only 
on-demand programs.

Figure 6-2 Program Listings Window with On-Demand Programs

Note that the following options are set for on-demand programs in the Preferences page of 
the IP/TV Content Manager:

• Idle IP/TV Viewer Timeout

This option sets the number of minutes IP/TV Viewer can be paused or stopped before 
IP/TV Server terminates the connection.

• Scheduled Reservation and On-Demand Non-Preemption
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Customizing the Program Listings Window
This option sets the number of minutes ahead of time that bandwidth is allocated for 
scheduled programs. An on-demand program will not be assigned to the server during 
the allocated time if this would cause the capacity of the server to be exceeded when the 
scheduled program starts. 

On-demand programs that are active longer than this number of minutes may be 
preempted when the scheduled program starts if the server capacity would be exceeded. 
Setting to zero disables preemption but may cause the server capacity to be exceeded.

Customizing the Program Listings Window
You can customize the Program Listings window. The Program Filter buttons toolbar and 
Program Listings window toolbar are dockable, and you can change the look of the toolbar 
buttons. 

To set these toolbar options from the Program Listings window, click Settings>Customize 
Toolbar. 

Table 6-1 describes the parameters and options you can set in the Customize dialog box:

Table 6-1 Customize Dialog Fields

Note Any button you press remains selected until you unselect it.

Parameter Description

Toolbar Lists all the toolbars.

Toolbar name Lists the selected toolbar.

Show Tooltips If checked, displays a toolbar button’s tool tip.
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About the IP/TV Program Listings Window
Program Listings Menu Bar
Table 6-2 lists the commands on the Program Listings window menu bar.

Table 6-2 Program Listings Window Menu Bar Commands 

Menu Command Description

File Open (Ctrl+O) Displays an Open dialog box that you can use to locate and select the 
session description file for the program you want to launch manually. 

Print Prints the program listing as ASCII text. The printout includes the 
program name, start and stop date and time, description, and contact 
information as entered in the Content Manager.

Print Setup Configures the printer.

Exit Exits IP/TV Server.

Settings Configure IP/TV Server Sets IP/TV Server options. See the “Setting IP/TV Server Options” 
section later in this chapter.

Maintenance Mode Enables/disables IP/TV Server from serving upcoming or future 
scheduled programs or meeting new requests for on-demand programs. 
Existing programs will continue to play until completed.

Customize Toolbar Displays the Toolbar Customization dialog box.

View Enable All Enables all listed programs. Multiple programs can also be enabled by 
holding down the Shift or Ctrl keys while clicking to select the desired 
programs, then right clicking and selecting Enable Selected.

Enable Selected Enables the selected programs. Programs can also be enabled by double 
clicking on a program listing.

Note that you can also enable programs by right clicking on a disabled 
program and selecting Enable/Disable Program.

Disable All Disables all listed programs. Programs that are active at the time of 
disabling are terminated, and do not launch at the next scheduled time. 
Programs that are not active at the time of disabling do not launch at the 
next scheduled session.
IP/TV Administration and Configuration Guide6-8



Program Listings Menu Bar
Disable Selected Disables the selected program. The selected program that is active at the 
time of disabling is terminated, and does not launch at the next scheduled 
time. A program that is not active at the time of disabling does not 
launch at the next scheduled session.

Note that you can also disable programs by right clicking on an active 
program and selecting Enable/Disable Program.

Program Information 
(Ctrl+I)

Displays the Program Information window. You can also access Program 
Information Windows by right clicking on an active program and 
choosing Program Info.

Listing Show Selects display of on-demand, scheduled, manual, or active programs, 
and their listings for today, this week, this month, or this year.

Sort Listing Sorts program by program name, channel, start or end times.

Refresh Listing Downloads a new copy of the program listing.

Help Contents Displays the table of contents of the online help.

Using Help Displays information about using Windows Help.

About IP/TV Server Displays IP/TV Server version information.

Table 6-2 Program Listings Window Menu Bar Commands  (continued)

Menu Command Description
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About the IP/TV Program Listings Window
Program Listings Window Tools and Icons
Table 6-3 lists the tools and icons available on the Program Listings window. If you place 
your mouse pointer over a tool, a yellow box (a tool tip) pops up with a description of the 
tool.

Table 6-3 Program Listing Window Tools and Icons 

Icon Tool Description

Scheduled Program icon If present in the Session (left) column and green, indicates 
that the program is enabled and active. If gray, the program 
is enabled but not active. If red, the program is disabled. 

OnDemand Program icon If present, indicates that an on-demand program is active.

Launch Session button Opens a dialog box that you can use to locate and select the 
session description file. See the “About Session Description 
Files” section in this chapter for the program you want to 
launch manually. 

 Refresh Listings button Downloads a new copy of the program listing from the 
Content Manager.

Enable/Disable
Program button

Enables or disables serving of the selected program. A 
program that is active at the time of disabling is terminated, 
and does not launch at the next scheduled time. A program 
that is not active at the time of disabling does not launch at 
the next scheduled session.

Program Information 
button

Displays program information for the selected program. 
(Figure 6-4 shows an example of a Program Information 
window.)
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Program Listings Window Tools and Icons
Maintenance Mode Enable or disables IP/TV Server from serving upcoming or 
future scheduled programs or meeting new requests for 
on-demand programs. Existing programs will continue to 
play until completed.

Print Program Listings 
button

Prints the program listing as ASCII text. The printout 
includes the program name, start time, end time, description, 
and contact information as entered in the Content Manager.

Display Help button Displays online program listings help.

Show Today’s Listings 
button

Displays the program listings for today.

Show This Week’s Listings 
button

Displays the program listings for this week.

Show This Month’s 
Listings button

Displays the program listings for this month.

Show This Year’s Listings 
button

Displays the program listings for this year.

Show OnDemand 
Programs button

Displays on-demand programs in the Program Listing 
Window.

Table 6-3 Program Listing Window Tools and Icons  (continued)

Icon Tool Description
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Setting IP/TV Server Options
Setting IP/TV Server Options
The Configure IP/TV Server dialog box allows you to configure server options. To set 
options from the Program Listing window, click Settings>Configure IP/TV Server. 

The following subsections detail the options available on the Server, Scheduler, Windows, 
and OnDemand tabs.

Server Tab
Use the Server tab to set options for the Primary and Secondary Content Manager. 
Table 6-4 describes the options you can set in the Server tab dialog box.

Note The Secondary Content Manager is used only if the Primary Content Manager is 
down for service or stops operating. 

Show Scheduled Programs 
button

Displays scheduled programs in the Program Listing 
window.

Show Manual Launch 
Programs button

Displays manually launched programs in the Program 
Listings window.

Show Active Programs 
button

Displays active programs in the Program Listings window.

Status bar Displays messages reflecting the current status of the IP/TV 
Server Program Listings window.

Table 6-3 Program Listing Window Tools and Icons  (continued)

Icon Tool Description
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Scheduler Tab
Table 6-4 Server Tab Options

Scheduler Tab
Use the Scheduler tab to set Server launch and polling options. Table 6-5 describes the 
options you can set in the Scheduler tab dialog box.

Option Description

IP/TV CM Host 
(Primary and 
Secondary)

Specifies the IP address or hostname of the Content 
Manager from which the program listing is obtained, in 
addition to any proxy server data.

Port No. Specifies the HTTP server port number. The default value is 
80. For firewall purposes, this may be set to some number 
other than 80.

Use Proxy Server Specifies the name and port number of the Proxy Server.

IP/TV Server RTSP 
Port

Specifies the RTSP port number. The default port setting is 
85541.

1 Because this is also the default setting for the server on the Content Manager, changing this 
setting will affect communication between the Content Manager and the Server, and will 
prevent operation if both are not the same.

Use SDP Listener If checked, IP/TV Server obtains program listings from the 
SDP listener or LocalHost.

Table 6-5 Scheduler Tab Options 

Option Description

Automatically start 
IP/TV Server after 
system reboot

Automatically starts IP/TV Server after system reboots and 
before user login.

Enable Auto-launch If checked, causes the server to launch programs 
automatically according to the schedule set by the Content 
Manager. The default is checked.

Poll for Auto-launch Sets the interval (in seconds) after which IP/TV Server 
checks for programs it is scheduled to launch. The default is 
10. The allowed range is 10 to 40.
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Setting IP/TV Server Options
Windows Tab
Use the Windows tab to customize headers in the Program Listings window, and to set 
Program Details windows to launch as hidden, minimized, or normal. Table 6-6 shows the 
options you can set in the Windows tab dialog box:

Table 6-6 Windows Tab Options

Poll for Program 
Listing every

Sets the interval (in seconds) after which IP/TV Server 
downloads a new copy of the program listing. The default is 
1800. The allowed range is 100 to 1,000,000.

Option Description

Select the Fields: Displays the headers that currently appear in the Program 
Listing Window. To remove a header, select it and use the 
arrow to move it to the Available Fields panel.

Available Fields Displays a list of the fields that are available to be used as 
headers in the Program Listings window. To add a header to 
the Program Listing window, select it and use the arrow to 
move it to the Select the Fields panel.

Show Program Details 
As

Use the radio buttons to set session windows to launch 
minimized, hidden, or normal. Specify hidden for optimal 
performance and an uncluttered desktop, and launch 
Program Details windows as needed by double clicking on 
the active program in the Program Listings window.

Table 6-5 Scheduler Tab Options  (continued)

Option Description
IP/TV Administration and Configuration Guide6-14



OnDemand Tab
OnDemand Tab
Use the OnDemand Tab to set options for on-demand files. Figure 6-3 shows an example 
of the OnDemand tab dialog box.

Figure 6-3 OnDemand Tab Dialog Box

Table 6-7 shows the options you can set in the OnDemand tab dialog box.

Table 6-7 OnDemand Tab Options

Option Description

MediaRoot Path Indicates the path where the server manages media files for 
all programs.

Enable Load 
Balancing

If checked, defines the server as part of the on-demand 
cluster. If unchecked, IP/TV Server will not be able to 
received video on-demand requests from the Content 
Manager.
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Viewing Program Information
Viewing Program Information
Program Information windows display information about a selected program. You can 
access Program Information windows in four ways:

• Select a program in the program listing and click the Show Program Information icon 
on the toolbar.

• Select a program in the Program Listings window, right click, and select Program Info.

• Select a program in the Program Listings window, then click View>Program 
Information.

• Select a program on the Program Listings window and press the Ctrl+I keys.

Figure 6-4 shows an example of a Program Information Window.

Figure 6-4  Program Information Window
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Monitoring Server Program Statistics
Table 6-8 lists the tools available on the Program Information window.

Table 6-8 Program Information Window Tools

Monitoring Server Program Statistics
When IP/TV Server launches a scheduled or on-demand program, the Program Details 
window is either hidden, launched minimized, or launched in normal fashion. Click 
Settings>Configure IP/TV Server>Windows on the Program Listings window to set this 
option. 

Scheduled programs can serve either prerecorded files are live-capture, but there are small 
differences in the Program Details window. The following sections describe the 
prerecorded file and live-capture Program Details windows, and the commands, tools, 
buttons, and indicators available on the windows.

Icon Tool Description

Enable button Enables serving of the elected program.

Disable button Disables serving of the selected program. 
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Monitoring Server Program Statistics
Prerecorded File Program Details Window
The Program Details window can display information about the video, audio, and web 
presentation portions of the program. No video image is displayed. 

Figure 6-5 shows an example of a Program Details window for a prerecorded file.

Figure 6-5 Program Details Window for a Prerecorded File
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IP/TV Server Program Details Window Menu Bar
IP/TV Server Program Details Window Menu Bar
Table 6-9 lists the commands available on the Program Details window menu bar. 

Table 6-9 Program Details Window Menu Commands

Menu Command Description

File Switch to Program 
Listings (Ctrl+W)

Changes the active window from the Program 
Details window to the Program Listings 
window.

Close (Ctrl+F4) Closes the current window.

Video Play (Ctrl+P) Plays or resumes the current program.

Pause (Ctrl+A) Pauses the current program.

Stop (Ctrl+S) Stops the current program.

Show Preview Toggles between showing or hiding the preview 
window. (Live-capture only.)

Window Always on Top If checked, the Program Details window is 
always on top, even if it is not the active 
window. 

Stats Window Displays video, audio, SlideCast, and Web 
Presenter information. 

Help Contents Displays the table of contents of the online 
help.

Using Help Displays documentation about using Windows 
Help.
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Monitoring Server Program Statistics
IP/TV Server Program Details Window Icon, Buttons, and 
Statistics

Table 6-10 lists the icons and button and indicators available on the Program Details 
window. 

Table 6-10 Program Details Window Tools and Indicators

Icons Button Description

Play/Pause 
button

Plays the current program. This button 
toggles to pause a program.

Pause/Play 
button

Pauses the current program. This button 
toggles to resume playing a program.

Stop button Stops the current program.

PDU Spacing 
field

An integer representing the number of 
milliseconds between each PDU 
transmit.1

1 Do not alter this value except under the direction of Cisco Systems Technical Support.

Auto-Repeat 
check box

Applies to prerecorded file server only. 
When checked, automatically repeats the 
current file. Overrides the repeat schedule 
set in the Content Manager.
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IP/TV Server Program Details Window Icon, Buttons, and Statistics
Table 6-11 describes the program statistics displayed in the Program Details window. The 
display is the same for both prerecorded programs and live-capture programs.

Table 6-11 Program Details Window Program Statistics

Statistic Description

Specify Frame Rate Allows the maximum frame rate to be modified. (Only 
available on live-capture or MPEG file programs.)

Frame Rate Indicates the frames per second of data being 
transmitted on the network.

Data Rate Indicates the amount of data in kbps being transmitted 
on the network.

Duration Indicates the elapsed time for the current program.

Dimensions Indicates the video image size in pixels (width and 
height).

Color Depth Indicates the color depth in bits.

Video Codec Indicates the compression format of the video data. 

Video IP Shows the IP multicast or unicast address used by the 
video packet stream.

Video Port Shows the UDP port number used by the video packet 
stream.

Video TTL Indicates TTL setting for the video data.

Audio Sample Rate Indicates sampling rate in Hz of audio data.

Audio Format Indicates which audio codec has been used to compress 
audio data, or displays the audio format for 
uncompressed audio.

Audio IP Indicates IP multicast address used by the audio packet 
stream.

Audio Port Indicates the UDP port number used by the audio 
packet stream.

Audio TTL Indicates the TTL setting for the audio data.

Driver Info Indicates which Cisco driver is processing the video 
and audio data, and indicates the driver version number.
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Monitoring Server Program Statistics
Capture Program Details Window
The video capture device configuration options are set in both the IP/TV Server using the 
Capture Program Details window and the video capture card. After using the IP/TV 
Content Manager to create a program, the IP/TV Server uses the default capture device 
settings, which can be adjusted during a session. The configuration options depend on the 
capture card you are using.

Figure 6-6 shows an example of the Capture Program Details window.

File File path of media file being served (if applicable.)

Presenter Status Current actions of Web Presenter.

Presenter URL Current URL Web Presenter is using.

Table 6-11 Program Details Window Program Statistics (continued)

Statistic Description
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Capture Device Configuration Options
Figure 6-6 Program Details Window—Live-Capture Session

Capture Device Configuration Options
The Capture Program Details window displays information about the streams present in a 
program. Some capture devices will allow you to preview the audio/video source in the 
Video Image field when you click Video>Show Preview.

Note You should not change the value for protocol data units (PDUs) spacing without 
direction from Cisco Systems Technical Support.
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Monitoring Server Program Statistics
Note For information on settings for the H.261, MPEG1, MPEG2, and MPEG4 codecs, 
see the “Live Capture and File Format Reference” appendix in this manual. 

Note MPEG capture devices do not allow video preview.

Non-MPEG Capture Devices
For non-MPEG devices, IP/TV Server provides the following two sets of configuration 
options to let you finetune a live-capture program using an interface to the IP/TV 
multimedia networking software:

• Audio format options

• Capture settings

Note These options only apply to the capture server, and can only be changed if the 
current program is paused or stopped. While the program is playing, the Configure button 
is disabled.

Follow these steps to set audio format options (non-MPEG):

Step 1 On the Capture Program Details window, click the Pause or Stop button to 
pause or stop the current program.

Step 2 Click Configure. The Capture Device Configuration window appears.

Step 3 In the Type list, select Audio Format and click Configure. The Audio Format 
Setting window appears.
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Capture Device Configuration Options
Step 4 Adjust option values as appropriate, and click OK. Depending on the encoding, 
Sample Rate and Channels selected will vary.

Step 5 Click Close to save settings. 

Step 6 On the Capture Program Details window, click Play to play the program.

See Table A-2 and Table A-3 for a list of available audio formats and their approximate 
bandwidth requirements and Realtime Transport Protocol (RTP) payloads. The default 
values for a given program are set when the program is defined in the Content Manager.

Follow these steps to override the default capture settings:

Step 1 On the Capture Program Details window, click Pause or Stop to pause or stop 
the current program.

Step 2 Click Configure. The Capture Device Configuration window appears.

Step 3 In the Type list box, select Capture Settings and click Configure. 

Step 4 Adjust option values as appropriate, and click OK.

Table 6-12 describes the capture device configuration options.

Note Except for Audio Format and Capture Settings, the choices in the Type list box are 
set by the capture device itself and normally should not be modified.

Note Winnov Videum AVI capture card registers some configuration information per 
application. Therefore the configuration information set in IP/TV is specific for IP/TV and 
will not be able to change using other utilities, including Winnov's own configuration tools. 
The information is stored at 
HKEY_CURRENT_USER\Software\Winnov\Videum\iptvserv.exe. 
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Monitoring Server Program Statistics
Table 6-12 Capture Device Configuration Options

MPEG1 Capture Devices
For MPEG1 live capture, the following configuration options are specific to the FutureTel 
card only. For the Optibase card configuration options, refer to the “MPEG2 Capture 
Devices” section later in this chapter.

Option Default Description

Maximum 
Frame Rate 

30

(Content 
Manager 
setting)

Determines the maximum frame rate used by the IP/TV Server for this session. 
Higher values increase video quality but consume more bandwidth on the network. 
This option can be used to limit network bandwidth consumption.

Maximum 
Data Rate 

1150 kbps

(Content 
Manager 
setting)

Determines the maximum amount of data that the IP/TV Server will transmit on the 
network for this session (including both audio and video streams). This option can 
be used to limit network bandwidth consumption.1

1 If you are sending the traffic over a link, you will need to compensate for the increase in data rate (up to 20 percent) caused by 
the overhead of different link layer framing.

Video 
Buffers

5 Determines the number of buffers used by the capture device. Low values improve 
synchronization. Some capture devices may require higher values.

Use DOS 
Memory

Unchecked Determines whether the capture device uses DOS memory (when checked) or 
extended memory (when unchecked). For some capture devices, DOS memory may 
be faster; refer to the documentation shipped with the capture device.

Capture 
Audio

Checked Determines whether the session includes both video and audio (when checked) or 
video only (when unchecked).

Standard 
NTSC

Checked Tells the server whether the video device connected to the capture card uses U.S. 
and Japanese standard NTSC format (when checked) or European standard PAL 
format (when unchecked).

Cisco H.261 
Compression 
Quality

8 Determines the H.261 compression quality level. Typically, users perceive very little 
difference between a value of 7 and higher values. High values consume more 
network bandwidth.

SlideCast 
Settings

— Allows you to fine tune the SlideCast server settings.
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Capture Device Configuration Options
We recommend that you use the default settings, except for the configuration settings 
described in Table 6-13.

Table 6-13 FutureTel MPEG Card Configuration Options

On the capture card, specify whether the video source is either standard NTSC format or 
standard PAL format. Refer to the instructions provided with the specific capture card.

When you manually set the Format option on the PrimeView Video Configuration window, 
always set the Format option to standard NTSC Format option (checked) for both U.S. and 
Japanese devices and for the European standard PAL format.

MPEG2 Capture Devices
Install the Optibase encoder board in your computer and connect the audio and video 
signals to it according to the installation instructions that came with the Optibase card. You 
can install the card before or after installing IP/TV Server on your computer.

Option
Recommended 
Setting Description

Multiplexer System On the System Stream Configuration window, choose the recommended 
setting from a list of multiplexer settings. This is a required setting.

Video Bit 
Rate

1,070,000 On the System Stream Configuration window, we recommend that you enter 
1,070,000 for the video bit rate. This is a recommended setting. You may 
experiment with this setting and the audio setting.1

1 See the “Live Capture and File Format Reference” appendix for recommended settings.

Audio Bit 
Rate

64,000 On the System Stream Configuration window, we recommend that you select 
64,000 for the audio bit rate. This is a recommended setting. You may 
experiment with this setting and the video setting.

Total Bit 

Rate

1,150,000 Although the system will accept a bit stream of up to 2.5 million bits per 
second, this will not necessarily improve the quality of your session and may 
degrade the performance of this and other programs depending on your 
client/server machines and your network configuration.
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Monitoring Server Program Statistics
Caution Do not install any other separate software or drivers that came with the 
Optibase card.

To set the properties of an Optibase MPEG capture card, click Configure after stopping a 
capture session. The dialog box as shown in Figure 6-7 appears.

The title in the dialog box indicates the name of the capture card IP/TV is configuring. 
Table 6-14 describes the important capture card settings. All other settings are geared 
toward advanced users and should not be changed unless directed by a Cisco technical 
representative.

Figure 6-7 Optibase Capture Card
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Temporarily Disabling a Program
Table 6-14 Optibase Capture Card Settings

Temporarily Disabling a Program
By default, all programs listed in the Program Listings window are enabled, that is, IP/TV 
Server will launch the programs and multicast the streams, SmallCast forward, and record 
according to the schedule set by the Content Manager.

If you need to prevent a program from being launched for some reason (for example, if a 
capture device fails, or a prerecorded file is deleted by accident and must be restored from 
backup), you can prevent the server from trying to multicast a scheduled program by 
disabling the program.

Option Default Description

Video Detect — Detects the color system (NTSC/PAL) of the video signal at the selected video 
input connector (composite/svideo).

Video Input options — Indicates settings for properties of the video input signal and for any processing 
that needs to be completed on the video input signal before it is encoded.

Video Output Rate — Indicates the target bitrate for just the video stream. This is value is computed 
from the specified network and audio bitrates.

Video Output Rate 
Microcode, 
Encoding Resolution

— The Microcode along with the encoding resolution determines whether the 
video is encoded to MPEG1, MPEG2 Full D1, or MPEG2 Half D1.

Audio — Indicates the type of audio source. For example, Unbalanced, Digital, or 
Balanced.

Left and Right Gain — Determines the gain applied to the left and right channel of the input audio 
signal before it is encoded.

Gain Lock — If checked, locks the Left and Right Gain values so that if the value is changed, 
the other one also changes.

Audio Rate 224 kbps Selects the target bit rate for the audio stream. This rate is used along with the 
specified network bit rate to compute the target bitrate for the video stream.1 2

1 The network bit rate, multiplexing, video output microcode, and video output encoding resolution values that are determined by 
Content Manager settings. Any changes you make to these parameters using these dialog boxes apply only until the next time the 
program is automatically launched by IP/TV. This applies to all live and file sessions.

2 The default audio rate, 224 kps, may leave too little bandwidth for video. When network bandwidth definition is low, IP/TV Server 
needs to reset the audio rate so there is enough left for video. We recommend to manually lower the local Optibase audio rate.
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Viewing Diagnostic Information
When a program is disabled, the session icon in the left-most column of the listing for the 
program changes from green to a red box.

To disable a program, use one of these procedures from the Program Listings window:

• Select the program and click Enable/Disable on the toolbar. 

• Select program and click View>Disable Selected.

• Right click the program and click Enable/Disable program.

• Right click the program and select the Program Info. option in the Program 
Information window. Click Disable to disable the program. 

Viewing Diagnostic Information
System administrators may diagnose problems with IP/TV on the client computer, network, 
MBone, or elsewhere using IP/TV Event Log Viewer and diagnostics windows in 
conjunction with Cisco Systems Technical Support.

IP/TV Event Log Viewer ships with all three IP/TV components: IP/TV Server, IP/TV 
Viewer, and IP/TV Content Manager. This is an advanced diagnostics tool and is hidden 
from the user of IP/TV Viewer. For IP/TV Server, you can access it by clicking the shortcut 
from the Start menu or by clicking psreport.exe in the Program File directory.

For information on solving a problem using IP/TV Event Log Viewer, contact Cisco’s 
Technical Assistance Center (TAC).

Manually Launching Programs
In most cases, you will want IP/TV Server to operate automatically so that the server 
multicasts programs according to the schedules set by the Content Manager. However, there 
might be circumstances under which you want to launch a program manually.

The following sections describe the procedures for launching prerecorded .avi, .rtp, and 
MPEG1 files and live-capture programs manually.

If no session description has been created, you must create one before it can be selected. 
See the “About Session Description Files” section later in this chapter.
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Manually Launching Prerecorded Files
Manually Launching Prerecorded Files
Follow these steps to manually launch a prerecorded file:

Step 1 On the Program Listing window, click File>Open, or click Launch Session. 
The File Open dialog box appears.

Step 2 In the Files of Type list, click File Server Session. A list of all available 
prerecorded file session description files (.svr) appears in the File Name list. See 
the “About Session Description Files” section later in this chapter.

Step 3 Locate and select the session description file for the program you want to launch.

Step 4 Click OK to launch the program.

Manually Launching Live-Capture Programs
Follow these steps to manually launch a live-capture program:

Step 1 On the Program Listings window, click File>Open, or click Launch Session. 
The File Open dialog box appears.

Step 2 In the Files of Type list, click Capture Session. A list of all available 
live-capture session description files (.cap) appears in the File Name list box. 
See the “Creating and Editing Capture Server Session Description Files” section 
later in this chapter.

Step 3 Locate and select the session description file for the program you want to launch.

Step 4 Click OK to launch the program. 

About Session Description Files
Session description files contain all the information about a program that IP/TV Server 
needs to know in order to multicast the program. 

For any program that is set up by the Content Manager, the session description file for the 
program is created automatically by the Content Manager, and you need not create or 
modify the file.
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Manually Launching Programs
For any program that you want to launch manually, without scheduling it through the 
Content Manager, you need to create either a prerecorded or live-capture server session 
description file for the program.

Creating and Editing Prerecorded File Server Session Description Files
When you installed IP/TV Server, a file named sample.svr was installed in the IP/TV Server 
directory, c:\Program Files\Cisco Systems\IPTV Server. This is the name of the default 
directory during installation. The name of your directory may be different. The format of 
this file is based on the draft specification for the IETF Session Description Protocol (SDP). 

Use this file as a template when you need to create a .svr file for a new session. You can 
simply copy sample.svr to a new filename and edit fields in the new file. These fields supply 
IP/TV Server with the IP addresses and UDP port numbers associated with the session, the 
IP Multicast Range of the session, the pathname of the file to be multicast, and the action 
to be taken by the server. 

Pay particular attention to the IP Multicast Range fields, which specify the TTL for 
multicast packets. These fields (one for the video packet stream, one for the audio packet 
stream, and one for the SlideCast stream) determine how far multicast session packets will 
be forwarded by routers on the network. You can use these fields to limit traffic loads on 
the network, or to prevent multicast session traffic from reaching the Internet.

For a discussion of IP multicast addresses, see the “Choosing IP Multicast Addresses and 
UDP Port Numbers” section later in this chapter.

Example 6-1 shows an annotated copy of sample.svr, and identifies the fields you may edit. 
Lines beginning with a semicolon (;) are comments referring to the subsequent line of the 
file. Do not modify any fields in the file except those indicated.

Note Microsoft Notepad is the recommended editing tool.
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About Session Description Files
Example 6-1 MPEG and .avi Server Session Description File (sample.svr)
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Manually Launching Programs
Creating and Editing Capture Server Session Description Files
When you installed IP/TV Server, a file named sample.cap was installed in the IP/TV 
Server directory, c:\Program Files\Cisco Systems\IPTV Server. This is the name of the 
default directory during installation. The name of your directory may be different. The 
format of this file is based on the draft specification for the IETF SDP. 

Use this file as a template when you need to create a .cap file for a new session. You can 
simply copy sample.cap to a new filename and edit fields in the new file. These fields 
supply IP/TV Server with the IP addresses and UDP port numbers associated with the 
session and the IP Multicast Range of the session. 

Pay particular attention to the IP Multicast Range field which specify the TTL for multicast 
packets.These two fields (one for the video packet stream, the other for the audio packet 
stream and SlideCast) determine how far multicast session packets will be forwarded by 
routers on the network. You can use these fields to limit traffic loads on the network, or to 
prevent multicast session traffic from reaching the Internet.

Example 6-2 shows an annotated copy of sample.cap, and identifies the fields you must 
edit. Lines beginning with a semicolon (;) are comments referring to the subsequent line of 
the file. Do not modify any fields in the file except those indicated.

For information on IP multicast addresses and ranges, and guidelines on limiting traffic on 
networks, see the “Administering the IP/TV Content Manager” chapter. You can also refer 
to the Multimedia Networking Concepts Guide, which is located at 
http://www.cisco.com/iptv/. This guide is available in PDF format.
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About Session Description Files
Example 6-2 Capture Server Session Description File (sample.cap)
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Manually Launching Programs
Choosing IP Multicast Addresses and UDP Port Numbers
This section provides some guidelines to use when choosing IP addresses and UDP port 
numbers for multicast sessions.

• IP multicast addresses

IP multicast addresses are Class D addresses in the range 224.0.0.0 through 
239.255.255.255. 

Some Class D addresses are permanently or dynamically assigned to specific functions 
such as routing and conferencing. To prevent conflicts, you should not choose addresses 
in the range 224.0.0.0 through 224.255.255.255.

A subset of Class D, the range from 239.0.0.0 to 239.255.255.255, is set aside as 
“administratively scoped IP multicast addresses.” These addresses are set aside for 
local/administrative use. We recommend that when you assign IP multicast addresses to 
sessions, you choose addresses in this range.

Administratively scoped IP multicast addresses are described in more detail in the 
“Setting Up IP/TV Content Manager” chapter. You can also refer to the Multimedia 
Networking Concepts Guide which is located at http://www.cisco.com/iptv/. This guide 
is available in PDF format.

• UDP port numbers

A UDP port number can be any number in the range from 0 through 65535. However, 
as with IP multicast addresses, some addresses in this range are permanently or 
dynamically assigned to specific protocols or functions.

In session description files, we recommend that you use UDP port numbers in the 
following ranges: 16,384 to 32,766 for audio and 49,152 to 65,534 for video. Note that 
the numbers must be even.

Setting Up Audio-Only and Video-Only Programs
Programs can include an audio stream or a video stream. Setting up the prerecorded file 
server or the capture server to multicast only audio or video is one way to reduce traffic on 
the network.

These procedures apply to both prerecorded file and capture server session description files. 
See Example 6-1 and Example 6-2 for sample server session description files.
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Pruning Transmission of Data
Follow these steps to set up a session description file that multicasts only a video packet 
stream:

Step 1 Fill in the UDP port field in the mvideo line.

Step 2 Fill in the IP address field in the cvideo line.

Step 3 Set the UDP port field in the maudio line to zero.

Step 4 Set the IP address field in the caudio line to zero.

Follow these steps to set up a session description file that multicasts only an audio packet 
stream:

Step 1 Fill in the UDP port field in the maudio line.

Step 2 Fill in the IP address field in the caudio line.

Step 3 Set the UDP port field in the mvideo line to zero.

Step 4 Set the IP address field in the cvideo line to zero.

When only one prerecorded media (audio or video) are presented, the session will be an 
audio only or video only session.

Pruning Transmission of Data
The IP/TV Server can automatically prune transmission of data based on whether there are 
any clients tuned in to a particular program. This feature saves network bandwidth by 
allowing more programs to be transmitted simultaneously whenever it is likely that one or 
more of the programs will not have any listeners at a given point in time. It works on a “per 
destination” basis where a destination is either the multicast address for the session or one 
of the unicast destinations. 

You must disable this feature if a server is being used to send to one or more destinations 
that do not have a backchannel, for example, a one-way satellite broadcast. To disable this 
feature, comment in (delete the semicolon preceding the entry) the following entry in the 
iptv.ini file: 

[msock]

RTPSourcePruning=off
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Pruning Transmission of Data
By default this feature is turned on. You can reenable it by changing off to on, or by 
removing the entry entirely. The feature is either on or off for a particular server for all 
programs (and, therefore, all destinations) at once.

If you need some programs pruned and others not, we recommend two separate servers. 
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